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FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

Class A Declaration of Conformity

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and 
can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense. 

Industry Canada Class A Notice

This Class A digital apparatus meets all the requirements of the Canadian Interference-Causing Equipment Regulations.

Avis de Conformation Classe A de l’Industrie Canada 

Cet appareil numérique de la Classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.

Dieses Gerät wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funkentstörbestimmungen 
geprüft. Es ist jedoch möglich, dass die Funkentstörbestimmungen unter ungünstigen Umständen bei anderen Gerätekombinationen nicht eingehalten werden. 
Für die Einhaltung der Funkentstörbestimmungen einer gesamten Anlage, in der dieses Gerät betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Die Einhaltung zutreffender Bestimmungen hängt davon ab, dass geschirmte Ausführungen benützt werden. Für die Beschaffung richtiger Ausführungen ist der 
Betreiber verantwortlich.

Software License Agreement

Before using the Software, please carefully read the following terms and conditions. BY USING THIS SOFTWARE, YOU SIGNIFY THAT YOU HAVE 
ACCEPTED THE TERMS OF THIS AGREEMENT.  If you cannot or do not accept these terms, you may return the entire package within ten (10) days to 
the Distributor or Dealer from which you obtained them for a full refund.

Electronics For Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included 
with the GA-1040 you have purchased, including without limitation the PostScript® software provided by Adobe Systems Incorporated.

You may:

a. use the Software solely for your own customary business purposes and solely with GA-1040;

b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with GA-1040 in a special encrypted format (“Coded 
Font Programs”) to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols (“Typefaces”) solely for your own 
customary business purposes on the display window of the GA-1040 or monitor used with GA-1040;

c. use the trademarks used by Electronics For Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to GA-1040 provided the transferee agrees to be bound by 
all of the terms and conditions of this Agreement.

You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600 dots per inch or greater, or to generate fonts or typefaces 
for use other than with GA-1040;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as 
necessary for use with the GA-1040 unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to be made, 
any copies of that certain portion of the Software which has been included on the GA-1040 hard disk drive. You may not copy the documentation; 

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.



                
Proprietary Rights

You acknowledge that the Software, Coded Font Programs, Typefaces, and Trademarks are proprietary to Electronics For Imaging and its suppliers and that title 
and other intellectual property rights therein remain with Electronics For Imaging and its suppliers. Except as stated above, this Agreement does not grant you 
any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or licenses in respect of the Software, 
Coded Font Programs, Typefaces, or Trademarks. You may not adapt or use any trademark or trade name which is likely to be similar to or confusing with that of 
Electronics For Imaging or any of its suppliers or take any other action which impairs or reduces the trademark rights of Electronics For Imaging or its suppliers. 
The trademarks may be used only to identify printed output produced by the Coded Font Programs. At the reasonable request of Electronics For Imaging, you 
must supply samples of any Typeface identified with a trademark.

Confidentiality

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need 
to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

Remedies

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, or Trademarks will result in automatic termination of this license and 
will make available to Electronics For Imaging other legal remedies.

Limited Warranty And Disclaimer

Electronics For Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without 
significant errors that make it unusable. Electronics For Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning 
GA-1040 to Electronics For Imaging or an authorized dealer) will be, at Electronics For Imaging’s option, to use reasonable commercial efforts to attempt to correct 
or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. Some 
states/jurisdictions do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.

For warranty service, please contact your authorized service/support center.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES 
OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION 
OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics For Imaging does not warrant that 
the operation of the Software will be uninterrupted or error free or that the Software will meet your specific requirements.

Limitation Of Liability

IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST 
PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF 
THE SOFTWARE OR CODED FONT PROGRAMS, HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL 
APPLY EVEN IF ELECTRONICS FOR IMAGING HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT 
THE PRICE OF THE GA-1040 REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT 
APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government 
licenses. Your failure to comply with this provision is a material breach of this Agreement.

Government Use

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted 
Right Clause at 48 CFR 52.227-19, as applicable.

Third Party Beneficiary

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) is a third-
party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the 
Typefaces and the Trademarks licensed hereby. Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics 
For Imaging.



  
General

This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between you and Electronics For Imaging, and supersedes any other communications or advertising with respect to 
the Software and Coded Font Programs.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics For Imaging, Inc., Attn.: Licensing Dept. or see Electronics For Imaging’s web 
site at www.efi.com.

Electronics For Imaging
303 Velocity Way
Foster City, CA 94404
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This manual describes how to install the user software for the TOSHIBA GA-1040™ 
and set up printing from Microsoft Windows and Apple Mac OS computers. 
For information about setting up network servers and clients to use the GA-1040, 
see the Configuration Guide. For general information on using the copier, your 
computer, your application software, or your network, see the manuals that 
accompany those products.

NOTE: The term “GA-1040” is used in this manual to refer to the TOSHIBA 
GA-1040. The name “Aero” is used in illustrations to represent the GA-1040.

• User Software CD

• User Documentation CD

• Release Notes

Conventions
The following icons are used in this manual:

Indicates features that require the Postscript option.

Indicates features and functionality for which a hard disk drive is required.

About the documentation
This manual is part of the set of GA-1040 documentation, which includes the 
following manuals for users and system administrators:

• The Configuration Guide explains basic configuration and administration of the 
GA-1040 for the supported platforms and network environments. It also includes 
guidelines for setting up Windows NT and Novell NetWare servers to provide 
Adobe PostScript printing services to clients.

• Getting Started describes how to install software to enable users to print to the 
GA-1040. Specifically, it describes installation of the PostScript printer drivers, 
printer description files, and other software provided on the User Software CD. 
It also explains how to connect each user to the network.

Introduction
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• The Printing Guide describes the printing features of the GA-1040 for users who 
send jobs via remote workstations on the network.

• The Job Management Guide explains the functions of the Fiery® client utilities, 
including the Command WorkStation™, and how they can be used to manage jobs. 
This book is intended for an operator or administrator, or a user with the necessary 
access privileges, who needs to monitor and manage job flow, and troubleshoot 
problems that may arise. 

• Release Notes provide last-minute product information and workarounds for some of 
the problems you may encounter.

Specifications
• 366MHz CPU

• 6GB hard disk drive (option)

• Supports AppleTalk, TCP/IP, and IPX protocols simultaneously

• Supports SNAP frame type using Ethernet port

• Supports thinnet shielded twisted pair (Fast Ethernet 100BaseTX or Ethernet 
10BaseT)

• Supports Adobe PostScript 3 (available as an option)

• Supports PCL printing (PCL6 for Windows computers)

• Supports IPP Printing (Windows 2000 only)

• Includes 81 PCL fonts

• Includes 136 fonts (available as an option) (126 Adobe Type 1 PostScript and 10 
TrueType)

In addition, two Adobe Multiple Master fonts are included and are used for font 
substitution in PDF files.

• Supports TopAccess

• Supports the Fiery Link client utility

• Supports Command WorkStation (available as an option)

Command Workstation is available for Windows only.
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• Supports FreeForm (available as an option)

• With dongle installed, GA-1040 supports DocBuilder Pro™ (available as an option)

DocBuilder Pro is available in Windows only. See your copier representative for 
details.

User software
A full set of user software is supported for the GA-1040.  

Adobe PostScript 
Printer Driver

Enables you to print to the GA-1040 from 
Windows 95/98/Me, Windows NT 4.0, and Mac OS 
computers; also supports special Fiery and PostScript 3 features. 
Windows 2000 users should use the Microsoft PostScript 
Printer Driver provided with Windows 2000.

PostScript Printer 
Description file (PPD)

For use with the PostScript printer driver that allows the 
GA-1040 to appear in popular applications’ Print and Page 
Setup dialog boxes. The GA-1040 PPDs provide information 
about the GA-1040 and your particular copier model to the 
application and printer driver you are using.

PCL6 Printer Driver Enables you to print to the GA-1040 from Windows 
computers; supports all special GA-1040 PCL6 print features.

MRJ
(Mac OS only)

Contains the Mac OS Runtime for Java installer v 2.2 and 
associated files.
NOTE: MRJ is required by all Java-based utilities, if MRJ is not 
detected the MRJ installer is automatically launched.

Fiery Link Enables you to monitor the status of connected servers and the 
print jobs sent to them.

Command WorkStation 
software (available as an 
option on a separate CD 
for Windows OS only)

Enables the operator to control the GA-1040 functions from 
Windows 95/98/Me and Windows NT 4.0 workstations. To 
use the Command WorkStation, see the Job Management Guide.

AGFA Monotype 
Font Manager 2000 
(for Windows, PCL 
printer drivers only) 

Enables you to manage your fonts on Windows, including 
installing, uninstalling, organizing, and previewing TrueType 
and Postscript Type 1 fonts.

Once installed, the software can be accessed with the Run Font 
Manager button from the Print Quality tab in the PCL printer 
driver.
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System requirements
To install the GA-1040 user software on a Windows or Mac OS computer, the 
computer must be equipped with a built-in or external CD-ROM drive.

Windows
To print to the GA-1040, you need:

• A Windows-based computer with an 80486, AMD, or Pentium processor

• Windows 95/98, Windows Millennium (Me), Windows 2000, or Windows NT 4.0

• At least 24MB of RAM for Windows 95/98

• At least 32MB of RAM for Windows Me

• At least 32MB of RAM for Windows NT 4.0

• At least 64MB of RAM for Windows 2000

With Microsoft Windows 95/98/Me, you also need:

• IPX/SPX or TCP/IP networking protocol installed

• Adobe PostScript Printer Driver version 4.2 or later for Windows 95/98/Me 
(version 4.3.1 is included with the user software)

With Microsoft Windows NT 4.0 and Windows 2000, you also need:

• IPX/SPX, TCP/IP or AppleTalk networking protocol installed

• Microsoft PostScript Printer Driver for Windows 2000 (included with your 
Windows 2000 operating system)

• Adobe PostScript Printer Driver version 5.1 for Windows NT 4.0 (version 5.1 is 
included with the user software)
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To use the Fiery utilities (Fiery Link™) you also need:

• Either Windows 95/98, Windows Me, Windows 2000, or Windows NT 4.0 with 
NT Service Pack 5 or later

• At least 48MB of RAM; 56MB of RAM is recommended

To use TopAccess, you also need:

• Either Netscape Communicator v4.5 or later, and Java enabled or Microsoft Internet 
Explorer v4.0.1 and Service Pack 1, or later, with Java enabled

NOTE: Netscape and Microsoft continue to release frequent updates to their browsers. 
As support cannot be guaranteed for all versions, use the versions specified above for 
best results.

• A monitor and video memory that supports 16-bit color at a minimum resolution of 
800 x 600

• A TCP/IP enabled network and the IP address or DNS name of the GA-1040

• Web Services enabled on the GA-1040

Mac OS
To print to the GA-1040 you need:

• A Mac OS-based computer and Apple System software 8.6 or later

• At least 16MB of RAM

• EtherTalk installed

• Adobe PostScript Printer Driver version 8.5 or later (version 8.7 is included with the 
user software)

To use the Fiery utilities (Fiery Link), you also need:

• A Mac OS-based computer and Apple System software version 8.6 or later

• At least 48MB of RAM; 56MB of RAM is recommended
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To use TopAccess, you also need:

• Netscape Communicator v4.5 or later, with Java enabled, or Internet Explorer 
v4.0.1 or later, with Java enabled

NOTE: Netscape continues to release frequent updates to its browser. As support cannot 
be guaranteed for all versions, use the version specified above for best results.

• A monitor and video memory that supports 16-bit color at a minimum resolution of 
800 x 600

• A TCP/IP enabled network and the IP address or DNS name of the GA-1040

• Web Services enabled on the GA-1040

Parallel port
To print to the GA-1040 using the parallel port, you need:

• A Windows computer with an 80486, AMD, or Pentium processor

• At least 24MB of RAM for Windows 95/98

• At least 32MB of RAM for Windows Me

• At least 32MB of RAM for Windows NT 4.0

• At least 64MB of RAM for Windows 2000

IPX (Novell)
To use the GA-1040 with an IPX (Novell) network, you need:

• A Novell server

• Novell NetWare software version 3.x, 4.x, or 5.x

• Support for Ethernet SNAP, Ethernet II, Ethernet 802.3, or Ethernet 802.2 
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Command WorkStation (option)
To run the Command WorkStation application from a remote workstation, you need:

• A Windows-based computer with a 200MHz Pentium processor

• Windows 95/98/Me, Windows NT 4.0 with NT Service Pack 5, or Windows 2000

• TCP/IP or IPX/SPX networking protocol installed

• A video adapter card with at least 2MB of video memory

• At least 32MB of RAM

• An 850MB (or greater) hard disk drive

• A 17" monitor that supports 16-bit color at a minimum resolution of 1024 x 768

DocBuilder Pro (option)
To run the Command WorkStation application with DocBuilder Pro (both available as 
options), you need:

• A Windows-based computer with a 333MHz Pentium processor

• Windows 95/98/Me, Windows NT 4.0 with NT Service Pack 5, or Windows 2000

• TCP/IP networking protocol installed

• A video adapter card with at least 2MB of video memory

• 64MB of RAM

• An 850MB (or greater) hard disk drive

• 90MB of available hard disk space

• A 17" monitor that supports 16-bit color at a minimum resolution of 1024 x 768
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This chapter describes installing software and setting up printing from a 
Windows-based computer running Windows 95/98/Me, Windows NT 4.0, 
or Windows 2000.

The general steps for installing the software are: 

• Install the PostScript printer driver or PCL printer driver and corresponding 
printer driver files.

• Set up the printer driver to communicate with the GA-1040.

• Install the Command WorkStation software on the designated Windows 95/98/Me, 
Windows NT 4.0, or Windows 2000 workstation(s).

• Configure the connection for Fiery Link and the Command WorkStation.

• Setup IPP printing for Windows 2000.

• Copy additional files from the User Software CD as needed.

Setting up PostScript and/or PCL printing with 
Windows 95/98/Me
To set up the GA-1040 as a PostScript or PCL printer, you must install the PostScript 
or PCL printer drivers for Windows 95/98/Me and the corresponding printer 
description files. You can also install the Agfa Monotype Font Manager. Afterwards, 
you configure the particular type of print connection between the workstation and the 
GA-1040. 

NOTE: Using the PostScript driver requires either the HDD option or the PostScript 
option installed on the copier.

The following procedure describes using the User Software CD to install the GA-1040 
as a local (LPT1) printer. The procedures after that describe completing the print 
connection for a network printer. 

Installing 
User Software 
on a Windows 
Computer
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If you are printing using SMB (Server Message Block) you can connect to 
the GA-1040 and install the printer drivers in a single procedure. To configure the 
GA-1040 for SMB printing, see “Setting up SMB printing with Windows 95/98/Me” 
on page 13.

If you are printing through a Novell server, see “To set up IPX (Novell) printing 
with Windows 95/98/Me” on page 12.

TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER FOR 
WINDOWS 95/98/ME

1. Insert the User Software CD into the CD ROM drive and select the Installr folder.

The User Software CD automatically begins the installation process with Auto insert 
notification enabled on Windows, which is the default setting. If the Welcome dialog 
box does not appear automatically when inserting the CD, you can begin installation 
by selecting the Installr folder from the CD and double-clicking the Setup.exe icon.

NOTE: See your Windows documentation for more information about the Auto insert 
notification.

2. Follow the on-screen instructions.

NOTE: Using the PostScript driver requires either the HDD option or the PostScript 
option installed on the copier.

TO CONFIGURE INSTALLABLE OPTIONS ON THE GA-1040 FROM THE POSTSCRIPT 
AND/OR PCL PRINTER DRIVERS FOR WINDOWS 95/98/ME

NOTE: The procedures for configuring installable options are similar for the PostScript 
and PCL6 printer drivers. For the purpose of the following instructions, the PostScript 
printer driver is used in illustrations.

1. In the Printers window, select the Toshiba e-STUDIO 45 icon for the PostScript or PCL 
printer driver. 

Choose Properties from the File menu. 

2. Select the Options tab.
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3. Select an installed option from the Pedestal or Finisher list.

Pedestal—Not Installed, Pedestal 1, Pedestal 2, Large Capacity Feeder

Finisher—Not Installed, Hanging Finisher, Finisher, Saddle Stitch Finisher

Punch Unit—Not Installed, 2 Hole Punch Unit, 2/3 Hole Punch Unit, 4 Hole Punch 
Unit (F), 4 Hole Punch Unit (S)

NOTE: Punch Unit is selectable only when “Finisher” or “Saddle Stitch Finisher” is 
selected as a Finisher option.

4. Click OK.

You are ready for the instructions for connecting to your network type. 
See “Completing the Windows 95/98/Me printer connection” on page 5.
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Using Two-Way Communication

When your printer driver is first installed, variable print options are displayed as 
“Printer’s Default”. If you have a TCP/IP enabled network, you can automatically 
update your printer driver to reflect current copier settings.

SETTING UP TWO-WAY COMMUNICATION FOR POSTSCRIPT AND/OR 
PCL PRINTER DRIVERS FOR WINDOWS 95/98/ME

1. Click Start in the Windows taskbar, choose Settings, and then choose Printers.

2. In the Printers window, select the icon for the GA-1040 PostScript or PCL printer 
driver. 

3. Choose Properties from the File menu.

4. Select the Options tab.

5. Click Auto Settings.

This will activate the Printer IP Address or DNS Name field.

6. Enter the GA-1040 IP address or DNS name in the Printer’s IP Address or DNS Name 
field and click Update.

7. If you would like your printer driver to display the printer’s current default settings 
when opened, click Auto Settings again, and check Update the Driver when opened.

8. Click Update.

9. Click Apply.
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Completing the Windows 95/98/Me printer connection

To print from Windows 95/98/Me you need to:

• Set up network servers, if any

• Set up the GA-1040 to accept print jobs from your computer

• Configure a port on each Windows computer for the network 

Completing the Windows 95/98/Me parallel port connection

Preparing a parallel port connection for Windows 95/98/Me requires specific BIOS 
settings on your computer, and specific port and printer settings for 
Windows 95/98/Me. In addition, a change to one of the GA-1040 Setup settings may 
be required if you choose to spool files to the GA-1040 rather than print directly.

TO PREPARE THE GA-1040 AND YOUR COMPUTER FOR PARALLEL PORT PRINTING

1. Connect the GA-1040 to the parallel port on your computer.

For instructions, see the Configuration Guide.

2. In Network Setup>Port Setup>Parallel Port Setup, set Enable Parallel Port to Yes.

For more information about GA-1040 Setup, see the Configuration Guide.

3. If you want to spool files to the GA-1040, set Port Timeout in Seconds to 10.
If you want to print directly to the GA-1040, set Port Timeout in Seconds to 5.

Setting this option to 10 seconds ensures that spooling is not interrupted due to 
timeout.

To do this: See:

Configure the parallel connection “Completing the Windows 95/98/Me parallel 
port connection” below.

Configure the IPX (Novell) connection “Completing the Windows 95/98/Me IPX/SPX 
or IPX (Novell) connection” on page 10.
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4. In your computer’s BIOS settings, set Parallel Port Mode to ECP.

To access the BIOS settings, restart the computer and press the key indicated on your 
monitor as soon as the computer starts up. You may have to scroll through several 
screens to reach the parallel port settings. After setting the Parallel Port Mode to ECP, 
save your changed setting and exit.

TO PREPARE THE PRINTER FOR PARALLEL PORT PRINTING

1. Click the Start button, point to Settings, and click Printers.

2. Click the Toshiba e-STUDIO 45 printer icon and choose Properties from the File menu.

3. Click the Details tab, and in the “Print to the following port” menu, select LPT 1: (ECP 
Printer Port).

NOTE: Check this selection carefully. It may read LPT 1: (Printer Port), which is not 
equivalent to LPT 1: (ECP Printer Port).

If this box does not read LPT 1: (ECP Printer Port), change the port setting now, as 
described in “To prepare the port for parallel port printing” on page 7, and then return 
to this procedure. You may need your Windows system CD.

4. If you changed the selection in the “Print to the following port” menu, click Apply.

A Warning dialog box may appear, stating that fonts you downloaded to the previously 
selected port may be lost; click OK.

5. Click Spool Settings.
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6. Select either “Spool print jobs so program finishes printing faster” or “Print directly 
to the printer.”

The selection you make depends on the action you took in step 3 on page 5:

• If you set the Port Timeout in Seconds to 10, you can select either option; however, 
spooling is faster.

• If you set the Port Timeout in Seconds to 5, select “Print directly to the printer.”

7. Select “Disable bi-directional support for this printer” and click OK.

8. Click Apply.

You are now ready to print from your applications to the GA-1040 with the parallel 
port. To confirm the connection, print a Windows test page.

9. Click the General tab.

10. Click Print Test Page and click OK.

11. Enter user and job identification information for accounting purposes, or whatever 
information is required at your site in the Job Notes window, and click OK.

If the test page prints successfully, you are ready to print from the computer.

TO PREPARE THE PORT FOR PARALLEL PORT PRINTING IN WINDOWS 95/98/ME

1. Click the Start button, choose Settings, and then choose Control Panel.

2. Double-click System.

The System Properties window appears.

3. Click the Device Manager tab.
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4. Double-click Ports.

5. Double-click the port with LPT1 in its name.

6. In the (LPT1) Properties dialog box, click the Driver tab and then click Update Driver. 

The Update Device Driver Wizard appears.

7. Click Next.
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8. Choose “Display a list of all the drivers in a specific location, so you can select the 
driver you want,” and then click Next.

9. Select “Show all hardware.”

10. From the Manufacturers list, select “(Standard port types).” From the Models list, 
select “ECP Printer Port” (not Printer Port). Click Next.

11. Click Yes in the Update Driver Warning dialog box.

12. Click Next.

Some files are copied.
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13. Click Finish, and then close the Printer Port Properties and System Properties dialog 
boxes.

You must restart your computer in order to activate the new settings. 

After Windows 95/98/Me restarts, you can complete the procedure described in “To 
prepare the printer for parallel port printing” on page 6.

Completing the Windows 95/98/Me IPX/SPX or IPX (Novell) connection

If you are printing through a Novell server, the Novell network and file server should 
be set up before you begin. The file server should be configured with a print server and 
print connection for the GA-1040. For details see your NetWare documentation and 
the Configuration Guide.

To print from Windows 95/98/Me computers over IPX (Novell), you must first set up 
IPX/SPX protocols, and then configure the GA-1040 by choosing the IPX port type, 
and entering the settings for the port you use.

TO SET UP IPX/SPX PRINTING

1. Click the Start button, choose Settings, and then choose Control Panel.

2. Double-click the Network icon.

Make sure that IPX/SPX-compatible Protocol is listed in the Installed Network 
Components section.

For instructions, see your Windows documentation.
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3. Double-click the IPX/SPX-compatible Protocol icon.

4. Click the Advanced tab.

5. In the Property list, click Frame Type. In the Value pop-up menu, select the Frame 
Type that corresponds to the one set during GA-1040 Network Setup.

If necessary, print the Setting list from the Control Panel to check which 
Frame Type(s) are configured.
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NOTE: Do not select Auto. Doing so may not select the Frame Type specified on 
the GA-1040.

6. Click OK and close the Network Control Panel.

7. When prompted to restart your computer, click Yes.

TO SET UP IPX (NOVELL) PRINTING WITH WINDOWS 95/98/ME

1. Click the Start button, choose Settings, and then choose Printers.

2. Click the Toshiba e-STUDIO 45 printer icon, and then choose Properties from the File 
menu.

3. Click the Details tab and click Add Port.

A list of connection options is displayed.

4. In the Add Port dialog box, specify the network path, or click Browse for a display of 
your network environment.

5. If you are using a NetWare file server, double-click the icon of the NetWare file server 
you want to use for printing to the GA-1040. 
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6. Click the printer icon labeled with the NetWare print queue you will use and click OK.

7. In the Add Port dialog box, verify that the network path is updated and click OK.

Your print jobs are transmitted to the specified print queue on the Novell file server. 
The GA-1040 polls the file server, and if jobs are present, they are transmitted to the 
GA-1040.

To confirm the connection, you can print a Windows test page.

8. Click the General tab, click Apply, and click Print Test Page.

If the test page prints successfully, you are ready to print from the computer.

Setting up SMB printing with Windows 95/98/Me

If you do not have a Novell network, you can print via SMB printing (also known as 
Windows printing or WINS printing). Printing by this method allows you to install 
the PostScript printer driver and printer description files, and print from your 
computer to a particular connection (Hold, Print, or Direct) on the GA-1040. To use 
PCL, you must install it from your User Software CD. These instructions assume you 
have the TCP/IP protocol and Client for Microsoft Networks installed.

To set up printing to a second or third connection on Windows 95/98/Me, you must 
install a new printer by repeating the procedure “To set up SMB printing on 
Windows 95/98/Me” on page 14. If you install more than one printer, give each a 
descriptive name during printer driver installation, such as Aero-Print or Aero-Hold, so 
you can easily identify printers.

BEFORE YOU BEGIN

• Configure the GA-1040 for SMB printing using TopAccess in Other Setup Options.

SMB printing is referred to as Windows Printing in Setup, on the TopAccess and on 
the Other tab of the Network Setup page. For more information, see the Configuration 
Guide.
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TO SET UP SMB PRINTING ON WINDOWS 95/98/ME

1. Double-click the Network Neighborhood icon to display your network environment.

2. Browse for the printer you would like to print to.

The printer name you are browsing for is the name entered in Server name set in 
Windows Printing setup on TopAccess.

If you are not able to locate your GA-1040, see your network administrator.

3. Double-click the name of the printer to display enabled print connections.

NOTE: The Hold and Print queues are displayed only when the HDD option is 
installed.

4. Double-click the name of the connection you want to print to.

The Printers dialog box appears, asking whether you would like to set up the printer.
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5. Select Yes to install the printer driver and printer description file for the selected 
connection.

The Add Printer Wizard appears. 

NOTE: You may want to install the drivers using the User Software CD.

6. Specify whether you print from MS-DOS based programs, and then click Next.

If you choose Yes you will be prompted to capture a printer port before proceeding 
with the installation. See your Windows documentation for details.

NOTE: With the HDD option, the PostScript driver is automatically installed. 
Continue the instruction with step 14.

7. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

8. If you are installing from the CD, type the name of the CD-ROM drive (for example, 
D:\), and click Browse. 

To install the PostScript driver, browse to English\Prntdrvr\Ps_drvr\Win_98_ME.

To install the PCL driver, browse to English\Prntdrvr\Pcl6_drvr\Win_98_ME.

Make sure “Oemsetup.inf” is selected.
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9. If you are installing a driver from the files you downloaded using the Installer, click 
browse.

To install the Postscript driver, browse to prntdrvr\Prntdrvr\PS_drvr\Win_98_ME.

To install the PCL driver, browse to prntdrvr\Prntdrvr\Pcl6_drvr\Win_98_ME.

Make sure “Oemsetup.inf” is selected.

10. Click OK. 

The path is copied to the Install From Disk dialog box.

11. Verify the path is correct, and click OK.

12. In the Printers box, select the appropriate GA-1040 file and click Next.

NOTE: The printer driver with UC uses Letter as the default paper size; the printer 
driver with EU uses A4 as the default paper size.

13. In the Available ports box, select the LPT1 port and click Next.

You will configure the port later, according to your network type.
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14. Using a maximum of 31 characters, enter a name for the GA-1040 (or leave the default 
name) in the Printer name box, and choose whether you want the GA-1040 to be your 
default printer. Click Next.

NOTE: Entering more than 31 characters may cause printing problems with some 
network applications.

15. You are asked if you would like to print a test page. Choose Yes and click Finish.

The necessary files are installed to your hard disk. If the test page prints successfully, 
you are ready to print from the computer.

Setting up PostScript and/or PCL printing with 
Windows NT 4.0 and/or Windows 2000
To set up the GA-1040 as a PostScript or PCL printer, you must install the PostScript 
or PCL Printer Driver for Windows NT 4.0 and/or Windows 2000 and its 
corresponding printer description files. You can also install the Agfa Monotype Font 
Manager. Afterwards, you configure a particular type of print connection between the 
workstation and the GA-1040. 

The following procedure describes using the User Software CD to install the GA-1040 
as a local (LPT1) printer. Adding a printer to a local system requires that you log in to 
your local Windows NT 4.0 and/or Windows 2000 workstation (not the network 
server domain) and that you are a member of the Administrators group. The 
procedures after that describe completing the print connection for a network printer.
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The procedure for adding a network printer is similar to adding a port. This procedure 
is described in “Completing the Windows NT 4.0 TCP/IP and LPR connection” on 
page 23 and/or “Completing the Windows 2000 TCP/IP and LPR connection” on 
page 26.

If you are printing using SMB (Server Message Block) you can connect to the 
GA-1040 and install the printer drivers in a single procedure. To configure 
the GA-1040 for SMB printing, see “Setting up SMB printing with Windows NT 4.0 
and/or Windows 2000” on page 30.

If you are printing through a Novell server, see “To set up IPX (Novell) printing for 
Windows NT 4.0 and/or Windows 2000” on page 28.

NOTE: The following procedures use Windows NT 4.0 illustrations with any 
Windows 2000 differences noted.

TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER FOR 
WINDOWS NT 4.0 AND/OR WINDOWS 2000

1. Insert the User Software CD into the CD ROM drive.

The User Software CD automatically begins the installation process with Auto insert 
notification enabled on Windows, which is the default setting. If the Welcome dialog 
box does not appear automatically when inserting the CD, you can begin installation 
by selecting the Installr folder from the CD and double-clicking the Setup.exe icon.

NOTE: See your Windows documentation for more information about the Auto insert 
notification.

2. Follow the on-screen instructions.

NOTE: Using the PostScript driver requires either the HDD option or the PostScript 
option installed on the copier.
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TO CONFIGURE INSTALLABLE OPTIONS ON THE GA-1040 FROM THE POSTSCRIPT 
PRINTER DRIVER FOR WINDOWS NT 4.0 AND/OR WINDOWS 2000

1. Click the Start button, choose Settings, and then choose Printers.

2. Click the Toshiba e-STUDIO 45 printer icon and choose Properties from the File menu.

3. Click the Device Settings tab, and scroll down to Installable Options. Specify the 
options installed on the GA-1040.

Pedestal Option—Not Installed, Pedestal 1, Pedestal 2, Large Capacity Feeder

Finisher—Not Installed, Hanging Finisher, Finisher, Saddle Stitch Finisher

Punch Unit—Not Installed, 2 Hole Punch Unit, 2/3 Hole Punch Unit, 4 Hole Punch 
Unit (F), 4 Hole Punch Unit (S)

NOTE: Punch Unit is selectable only when “Finisher” or “Saddle Stitch Finisher” is 
selected as a Finisher option.

4. Click OK.
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TO CONFIGURE INSTALLABLE OPTIONS ON THE GA-1040 FROM THE 
PCL PRINTER DRIVER FOR WINDOWS NT AND/OR WINDOWS 2000

1. Click the Start button, choose Settings, and then choose Printers.

2. Right-click the Toshiba e-STUDIO 45 icon and choose Document Defaults 
(Windows NT 4.0) or Printing Preferences (Windows 2000).

3. Click the Options tab.

4. Choose the Pedestal or Finisher menu and specify the options installed on the 
GA-1040.

Pedestal Option—Not Installed, Pedestal 1, Pedestal 2, Large Capacity Feeder
Finisher—Not Installed, Hanging Finisher, Finisher, Saddle Stitch Finisher
Punch Unit—Not Installed, 2 Hole Punch Unit, 2/3 Hole Punch Unit, 4 Hole Punch 
Unit (F), 4 Hole Punch Unit (S)

NOTE: Punch Unit is selectable only when “Finisher” or “Saddle Stitch Finisher” is 
selected as a Finisher option.

5. Click OK.
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Using Two-Way Communication

When your printer driver is first installed, variable print options are displayed as 
“Printer’s Default”. If you have a TCP/IP enabled network, you can automatically 
update your PCL printer driver to reflect current copier settings.

NOTE: Two-way communication is only available for the PCL printer driver on 
Windows NT 4.0 and Windows 2000.

SETTING UP TWO-WAY COMMUNICATION FOR PCL PRINTER DRIVERS 
FOR WINDOWS NT AND/OR WINDOWS 2000

1. Click Start in the Windows taskbar, choose Settings, and then choose Printers.

2. In the Printers window, select the Toshiba e-STUDIO 45 PCL printer driver icon. 

3. Choose Document Defaults (Windows NT) or Printing Preferences (Windows 2000) 
from the File menu.

4. Select the Options tab.

5. Click Auto Settings.

This will activate the Printer IP Address or DNS Name field.

6. Enter the GA-1040 IP address or DNS name in the Printer’s IP Address or DNS Name 
field and click Update.

7. If you would like your printer driver to display the printer’s current default settings 
when opened, click Auto Settings again, and check Update the Driver when opened.

8. Click Update.

9. Click Apply.
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Completing the Windows NT 4.0 and/or Windows 2000 printer 
connection

To print from Windows NT 4.0 you need to:

• Set up network servers, if any

• Set up the GA-1040 to accept print jobs from your computer

• Configure a port on each Windows NT computer for the network type

Completing the Windows NT 4.0 and/or Windows 2000 parallel port 
connection

The parallel port cable connects the GA-1040 to a single computer. Once you have 
installed the Windows NT 4.0 or Windows 2000 printer driver and the GA-1040 
PPD, complete the setup for parallel port printing.

TO SET UP PARALLEL PRINTING FOR WINDOWS NT 4.0 AND/OR WINDOWS 2000

1. Click the Start button, choose Settings, and then choose Printers.

2. Double-click the Toshiba e-STUDIO 45 icon and choose Properties from the Printer 
menu.

In the Ports tab, confirm that LPT1 (Local Port) is checked.

The GA-1040 is ready to accept parallel print jobs from your computer, using the 
Windows NT 4.0 or Windows 2000 PostScript printer driver and the GA-1040 PPD.

To do this: See:

Configure the parallel connection “To set up parallel printing for Windows NT 4.0 
and/or windows 2000” below.

Configure the TCP/IP (LPR port) 
connection

“Completing the Windows NT 4.0 TCP/IP and 
LPR connection” on page 23 or “Completing the 
Windows 2000 TCP/IP and LPR connection” on 
page 26

Configure the IPX (Novell) 
connection

“Completing the Windows NT 4.0 and/or 
Windows 2000 IPX (Novell) connection” on 
page 27.
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3. Click the General tab and click Print Test Page.

When you select print, your files are transmitted over the parallel port connection to 
the GA-1040.

4. Click the Sharing tab if you want to share the GA-1040 with network users. Select 
Shared (Windows NT 4.0) or Share as (Windows 2000), and select a share name.

Select the operating system or systems used by your network clients if you want to 
install a printer driver that those clients can download.

5. Click OK to exit the Printer Properties dialog box.

Completing the Windows NT 4.0 TCP/IP and LPR connection

Once you have installed the PostScript printer driver and printer driver files, complete 
the setup for the TCP/IP and LPR connection as follows:

• Prepare the GA-1040 to accept print jobs using TCP/IP and LPR protocols. 
(See the Configuration Guide for details.)

• Configure the workstation for the TCP/IP connection.

Before you continue, ask the system administrator for the IP address assigned to the 
GA-1040, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP Protocol and Microsoft TCP/IP Printing software should already be 
installed on the Windows NT 4.0 workstation.
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TO SET UP TCP/IP AND LPR PRINTING FOR WINDOWS NT 4.0

1. Open the Properties dialog box for the GA-1040, and click the Ports tab.

2. Click Add Port.

The available port types are displayed.

3. Select LPR Port and click New Port.

If the LPR port is not listed, install the TCP/IP network protocol and Microsoft 
TCP/IP printing software. See the Configuration Guide or your Windows NT 
documentation.

4. Enter the IP address of the GA-1040. 

If your network uses Domain Name Services (DNS), enter the DNS name assigned to 
the GA-1040 instead of the IP address.
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5. Press Tab and type one of the following names, depending on the GA-1040 connection 
you would like to print to.

direct—Jobs sent straight to the server without spooling.

hold—Jobs sent to the GA-1040 and held until the operator sends them to the next stage 
of processing.

print—Jobs spool to the GA-1040 and proceed to RIP and print according to the job 
setting.

NOTE: This name is case-sensitive; type it exactly as shown above.

The hold and print queues are only available with the HDD option. For more 
information on the Direct, Hold, and Print queues, see the Printing Guide.

6. Click OK.

The workstation checks the address or DNS name you entered and notifies you if it 
cannot resolve the address.

7. Click Close in the Printer Ports dialog box.

The new port configuration is reflected in the Ports tab. You must now close the 
Printer Properties dialog box to verify the connection. 

8. Click OK to close the Printer Properties dialog box. 

9. Reopen the Printer Properties dialog box.

10. Click the General tab and click Print Test Page.

When you print, your PostScript files are transmitted over the LPR Port connection to 
the GA-1040.

11. Click OK to close the Printer Properties dialog box.
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Completing the Windows 2000 TCP/IP and LPR connection

Once you have installed the PostScript printer driver and printer driver files, complete 
the setup for the TCP/IP and LPR connection as follows:

• Prepare the GA-1040 to accept print jobs using TCP/IP and lpr protocols. 
(For details, see the Configuration Guide.)

• Enable LPD or Port 9100 TopAccess. (For details, see the Configuration Guide.)

• Configure the workstation for the TCP/IP connection.

Before you continue, ask the system administrator for the IP address assigned to the 
GA-1040, as well as the subnet mask and the gateway address if they are used.

The TCP/IP Protocol and Microsoft TCP/IP Printing software should already be 
installed on the Windows 2000 workstation.

TO SET UP TCP/IP AND LPR PRINTING FOR WINDOWS 2000

1. Open the Properties dialog box for the GA-1040, and click the Ports tab.

2. Click Add Port.

3. Select Standard TCP/IP Port for Available port types and click New Port.

4. Click Next in the Add Standard TCP/IP Printer Port Wizard dialog box.

5. Enter the IP address of the GA-1040.

The IP address will automatically be entered for the Port Name.

6. Click Next.

The device will automatically be detected.
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7. Select Generic Network Card as Standard for Device Type if the device is not 
automatically detected, and click Next.

8. Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and 
then click Close from the Printer Ports dialog box. 

9. Click Ports in the Properties dialog box, and then click Configure Port.

The Configure Standard TCP/IP Port Monitor dialog box appears.

10. Select LPR.

11. Enter the queue name.

direct

print

hold

NOTE: The hold and print queues are available only with the HDD option.

12. Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.

Completing the Windows NT 4.0 and/or Windows 2000 IPX (Novell) 
connection

NOTE: The procedures for completing the IPX (Novell) connection for 
Windows NT 4.0 and/or Windows 2000 are similar. Windows NT 4.0 screen 
captures are used with relevant Windows 2000 differences noted.

Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling GA-1040 print jobs. 
The file server should be configured with a print server and print connection for the 
GA-1040. For details, see your NetWare documentation.

• Prepare the GA-1040 for IPX printing.

• Set up the IPX connection on the workstation.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client 
services should already be installed on the Windows NT 4.0 and/or Windows 2000 
workstation.
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TO SET UP IPX (NOVELL) PRINTING FOR WINDOWS NT 4.0 AND/OR 
WINDOWS 2000

1. Double-click Network Neighborhood (Windows NT 4.0) or My Network Places 
(Windows 2000).

2. Double-click NetWare or Compatible Network.

A list of NetWare servers is displayed.

3. Double-click the NetWare Tree or File Server on which the network administrator 
defined a print connection for the GA-1040.

You may have to log in to the file server to see the print connections.

4. Double-click the print connection defined for the GA-1040.

If the NetWare server does not have a suitable driver for the GA-1040 you may be 
asked if you want to set up the printer on your workstation.

5. Click Yes.
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6. Click OK to install the GA-1040 PostScript or PCL printer driver. (Follow the Add 
Printer Wizard.)

When installation is complete, a new printer window appears, with the name of the 
print queue on the NetWare server.

NOTE: PostScript is an option. For PostScript, install the PostScript Driver using the 
User Software CD.

7. Choose Properties from the File menu, and click the Ports tab.

The NetWare queue you just connected to is listed and checked as a port for the 
GA-1040. 

8. Click the General tab and click Print Test Page.

The printer Job Notes window appears.

9. Enter user and job identification information for accounting purposes, whatever is 
required at your site and click OK.

The GA-1040 polls the NetWare server for print jobs in the print connection defined 
for the GA-1040. When you print, your PostScript files are spooled to that connection 
and transmitted over the queue “port” to the GA-1040.

The test page job is listed in the queue window until it is printed.
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Setting up SMB printing with Windows NT 4.0 and/or 
Windows 2000

If you do not have a Novell network, you can print via SMB printing (also known as 
Windows printing or WINS printing). Printer driver installation for SMB printing via 
Point and Print is only available for the PostScript driver for Windows 95/98. You will 
need to install the drivers using the User Software CD. These instructions assume you 
have the TCP/IP Protocol and TCP/IP Printing software installed on the 
Windows NT 4.0 workstation.

To set up printing to a second or third connection, you must install a new printer by 
repeating the procedure “To set up SMB printing on Window NT 4.0 and/or 
Windows 2000” on page 30. If you install more than one printer, give each a 
descriptive name during printer driver installation, such as Aero-Print or Aero-Hold, so 
you can easily identify printers.

BEFORE YOU BEGIN

• Configure the GA-1040 for SMB printing using TopAccess in other setup options.

SMB printing is referred to as Windows Printing in Setup, on the TopAccess and on 
the other tab of the Network Setup page. For more information, see the Configuration 
Guide.

TO SET UP SMB PRINTING ON WINDOW NT 4.0 AND/OR WINDOWS 2000

1. Double-click the Network Neighborhood (Windows NT 4.0) or My Network places 
(Windows 2000) icon to display your network environment.
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2. Browse for the printer you would like to print to.

The printer name you are browsing for is the name entered in the Server name set in 
Windows Printing setup on the TopAccess. Refer to the Setting list for this 
information.

The amount of network traffic determines the amount of time required for the Browse 
function.

If you are not able to locate your GA-1040, see your network administrator.

3. Double-click the name of the GA-1040 to display enabled print connections.

NOTE: The hold and print queues are displayed only when the HDD option is 
installed. 

4. Double-click the name of the connection you want to print to.

The Printers dialog box appears, asking whether you would like to set up the printer.

5. Select Yes to install the printer driver and printer description file for the selected 
connection. 

The Add Printer Wizard appears.

NOTE: You may want to install the drivers using the User Software CD.
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6. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

7. If you are installing from the CD, type the name of the CD-ROM drive (for example, 
D:\), and click Browse. 

To install the PostScript driver, browse to English\Prntdrvr\Ps_drvr\Win_NT4 
(Windows NT 4.0) or English\Prntdrvr\Ps_drvr\Win_2000 (Windows 2000).

To install the PCL6 driver, browse to English\Printdrvr\Pcl6_drvr\Win_NT4 
(Windows NT 4.0) or English\Prntdrvr\Pcl6_drvr\Win_2000 (Windows 2000).

Make sure “Oemsetup.inf” is selected.

8. Click Open. 

The path is copied to the Install From Disk dialog box.

9. Verify the path is correct and click OK.
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10. In the Printers box, select the appropriate GA-1040 file and click OK.

NOTE: The printer driver with UC uses Letter as the default paper size; the printer 
driver with EU uses A4 as the default paper size.

The necessary files are installed to your hard drive.

Setting up IPP printing with Windows 2000

With Internet Printing Protocol (IPP), print jobs are sent to the GA-1040 over the 
Internet. 

NOTE: IPP printing is supported with Windows 2000 only.

IPP printing is supported directly for Windows 2000 computers; however, you must 
first install the “wpnpins.exe” patch file (available on the Windows 2000 Server 
Product CD). For information about this patch, contact the Microsoft Corporation.

NOTE: The IPP setup procedures are performed after installing the appropriate printer 
drivers. See “To install the PostScript or PCL printer driver for Windows NT 4.0 
and/or Windows 2000” on page 18.
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TO SET UP IPP PRINTING WITH WINDOWS 2000

1. Click the Start button, choose Settings, and then choose Printers.

2. Double-click the Add Printer icon and click Next.

3. Select Network printer and click Next.

4. Select “Connect to a printer on the Internet or on your intranet.” Enter an IP address 
or computer name in the URL window.

The URL for the printer is the IP address followed by “ipp/print” for HDD version or 
“ipp/direct” for diskless version.

5. Click Next.

6. Select Yes if you want the GA-1040 to be the default printer, if not, select No. 
Click Next.

7. Click Finish.
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Installing GA-1040 software
The User Software CD includes a software installer for Fiery Link. Fiery utility 
software is supported on Windows 95/98/Me, Windows NT 4.0, and Windows 2000, 
and must be separately installed on each user’s computer.

Command WorkStation software (available as an option) is provided on a separate 
CD and is supported with Windows 95/98/Me, Windows NT 4.0, and 
Windows 2000. It should be installed only on workstations that are designated for 
Command WorkStation use.

The AGFA Monotype Font Manager 2000 software allows you to install, uninstall, 
preview, sort, and create font groups. This software program is accessible from the 
GA-1040 printer drivers but must be purchased separately. For installation 
information, follow the install procedures on the AGFA Installer CD. Refer to the 
included online help for detailed information on how to use it.

Fiery Link

Before you begin installation determine the following:

• Where do you want to install the utility on your hard disk?

By default, the installer places Fiery Link in a folder called “Fiery” in the Programs 
folder.

• What do you want to name the utility folder in the Windows\Start Menu\Programs 
folder?

By default, the installer names the folder “Fiery.”
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TO INSTALL FIERY LINK

1. Insert the User Software CD into the CD ROM drive, and navigate to the software 
folders.

The User Software CD automatically begins the printer driver installation when Auto 
insert notification is enabled on Windows. To access the software installers, hold down 
the shift key after inserting the CD and then navigate to the appropriate software 
folders using Windows Explorer.

NOTE: See your Windows documentation for more information on Auto insert 
notification.

2. Double-click to open the Fiery Link folder.

3. Double-click the Setup.exe icon.

4. Follow the instructions in the Setup dialog boxes to complete installation.
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Use the following table as a guide when installing Fiery Link. For specific instructions, 
read the information in each dialog box.

Command WorkStation (option)

The Command WorkStation software is on the Command WorkStation CD. 
In addition to the Command WorkStation application software (available as an 
option), the installer installs Java files necessary to use Fiery Setup on the Command 
WorkStation. Before you begin this installation, determine the following:

• Where do you want to install the software on your hard disk?

By default, the installer places the Command WorkStation software in the 
Programs\Fiery folder on your hard disk.

• What do you want to name the Command WorkStation folder in the 
Windows\Start Menu\Programs folder?

By default, the installer names the folder “Command WorkStation.”

• Do you want to place a shortcut to the Command WorkStation application in your 
Windows\Start Menu\Programs\StartUp folder?

Placing a shortcut in the StartUp folder automatically launches the 
Command WorkStation application every time you restart your computer.

Name of dialog box: Action: When finished:

Welcome Read the Setup program 
introduction.

Click Next.

Software License Agreement  Read the license agreement. Click Yes.

Choose Destination Location Specify a hard disk location for the 
installed utility software.

Click Next.

Select Program Folder Specify a folder name for the software 
located on the Programs menu. By 
default the folder name is “Fiery.”

Click Next.

Setup Complete Acknowledge that the software 
installation is complete.

Click Finish.



38 Installing User Software on a Windows Computer
TO INSTALL COMMAND WORKSTATION SOFTWARE

1. Insert the Command WorkStation CD.

The Command WorkStation CD automatically begins the installation process with 
Auto insert notification enabled on Windows, which is the default setting. If the 
Welcome dialog box does not appear automatically when inserting the CD, you can 
begin installation by double-clicking the CStation folder from the CD and then 
double-clicking the Setup.exe icon.

NOTE: See your Windows documentation for more information on Auto insert 
notification.

2. Follow the instructions in the Setup dialog boxes to complete installation of 
Command WorkStation software.

Use the table below as a guide when installing Command WorkStation software. For 
specific instructions, read the information in each dialog box. 

Name of dialog box: Action: When finished:

Welcome Read the Setup program introduction. Click Next.

Software License 
Agreement

Read the license agreement. Click Yes.

Choose Destination 
Location

Specify a hard disk location for the 
installed Command WorkStation 
software.

Click Next.

Select Program Folder Specify a folder name for the 
Command WorkStation software 
located in the Programs menu.

Click Next.

Question Indicate if you want to place a shortcut 
to the Command WorkStation 
application in your StartUp folder.

Click Yes or No.

Setup Complete Click Finish to install MS Java VM 
5.00.3182 on your computer, if it is 
not already installed, or click Finish to 
complete Setup. 

Click Finish.
Restart your computer 
to initialize Command 
WorkStation and the 
Java files.
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Using the software for the first time
Before you can use the newly installed software, you must properly configure the 
connection to the GA-1040.

Configuring a connection for Fiery Link

You can use Fiery Link to monitor the status of the Fierys and view information about 
the print jobs sent to them. 

When you click the Edit Fiery List button, all GA-1040s on the local subnet appear 
in the Available Fierys list of the My Fiery List dialog box. You can specify which 
GA-1040 to connect to and monitor from this dialog box. If the GA-1040 is not in 
your local subnet, you can use Fiery Link options to manually configure a connection, 
or you can perform an advanced search to locate and connect to the GA-1040s 
anywhere on the network. The procedures below describe locating and connecting to 
a GA-1040 using manual and advanced search methods.

For information on using Fiery Link, see the Printing Guide.

NOTE: Fiery Link is supported only over TCP/IP.

TO CONFIGURE THE CONNECTION TO GA-1040 IN A LOCAL  SUBNET

1. Launch Fiery Link by double-clicking its icon or by choosing it from the 
Start>Programs>Fiery menu.

2. The Warning dialog box “No Fierys configured, please select a Fiery” appears. Click OK.

NOTE: If the Fiery is located on a different subnet an Error dialog appears. Click OK to 
dismiss the dialog box, and perform an Advanced IP search (see page 43), or Advanced 
Subnet search (see page 46).



40 Installing User Software on a Windows Computer
3. Click the Edit Fiery List button. 

The Edit My Fiery List dialog box opens, and all Fierys found appear in the Available 
Fierys area of the dialog box. 

NOTE: Only Fierys that support Fiery Link appear in the Available Fierys area.

4. To add a GA-1040 to the My Fiery List, select it and click the arrow button. 

The GA-1040 appears in the My Fiery List.

GA-1040 Name, Device Name 
(GA-1040), and IP Address

Arrow button
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Repeat step 4 for each GA-1040 you would like to add to the My Fiery List.

5. Click Apply to accept the changes to My Fiery List. 

6. Click OK. 

TO MANUALLY CONFIGURE THE CONNECTION FOR FIERY LINK

1. Click the Manual tab. Enter the DNS name or IP address of the GA-1040 and click the 
arrow button.

When the arrow button is clicked, Fiery Link checks for the specified GA-1040. If the 
GA-1040 is found, it appears in the My Fiery List. If it is not found, an error message 
appears. 

To add the GA-1040 to the My Fiery List without confirming its existence on the 
network, hold down the Ctrl key while clicking the arrow button. 

2. To give the GA-1040 a nickname, select it in the My Fiery List and click Modify.
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3. Select Use Nickname, and enter a nickname for the GA-1040.

4. Click OK.

5. Click Apply to accept the changes to My Fiery List.

6. Click OK.
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TO CONFIGURE THE CONNECTION FOR FIERY LINK USING AN 
ADVANCED IP SEARCH

1. Click the AutoSearch tab.

2. Click the Advanced button.
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3. To find all GA-1040 within an IP address range, enter an IP Address in the From IP 
field, and an IP address in the To IP field, and click the arrow button.

Repeat step 3 for each IP address range you would like to search. To remove an IP 
address range from the list, select the range in the IP Range/Subnet Addr. window and 
click the Remove button.

You can also search for the GA-1040 using a range of subnet values. For more 
information, see “To configure the connection for Fiery Link using an advanced 
subnet search” on page 46.

4. Click Search.

When the search is complete, all Fierys found appear in the Available Fierys area of the 
dialog box. 

If the GA-1040 was not found, and you would like to search again using the same 
parameters, click Refresh.
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NOTE: Only Fierys that support Fiery Link appear in the Available Fierys area.

5. To add a GA-1040 to the My Fiery List, select it and click the arrow button. 

The GA-1040 appears in the My Fiery List.

Repeat step 5 for each GA-1040 you would like to add to the My Fiery List.

6. Click Apply to accept the changes to My Fiery List. 

7. Click OK. 
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TO CONFIGURE THE CONNECTION FOR FIERY LINK USING AN 
ADVANCED SUBNET SEARCH

1. Click the AutoSearch tab.

2. Click the Advanced button and click the Subnet Addr. tab.
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3. Enter the IP address and subnet to search, and click the arrow button. 

The IP address and subnet to be searched appears in the IP Range/Subnet Addr. list. 
Repeat this procedure for each IP address and subnet you would like to search. 

To remove a value from the IP Range/Subnet Addr. list, select it and click the Remove 
button.
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4. Click Search.

When the search is complete, all GA-1040s found appear in the Available Fierys area of 
the dialog box. 

If the GA-1040 was not found, and you would like to search again using the same 
parameters, click Refresh.

NOTE: Only Fierys that support Fiery Link appear in the Available Fierys area.

5. To add a GA-1040 to the My Fiery List, select it and click the arrow button. 
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The GA-1040 appears in the My Fiery List.

Repeat step 5 for each GA-1040 you would like to add to the My Fiery List.

6. Click Apply to accept the changes to My Fiery List. 

7. Click OK. 

Configuring the connection for the Command WorkStation

The first time you launch Command WorkStation (available as an option), you are 
prompted to configure the connection to the GA-1040. 

BEFORE YOU BEGIN

• Print the Setting list from the Control Panel and note the IP Address of the GA-1040. 

You can also set up a Domain Name Server (DNS) for the IP address of the GA-1040. 
See your Windows system documentation for information.

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION

1. Launch Command WorkStation by double-clicking its icon or by choosing it from the 
Start>Programs menu.

2. Click OK.
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3. Enter the appropriate information for the GA-1040.

Nickname—Enter a name for the GA-1040. This name can be any name you wish; it 
does not have to match the actual Server Name of the GA-1040.

NOTE: The nickname cannot contain any of the following seven characters:
[ ] _ " ' <space> <tab>

Protocol—Choose the type of network protocol you are using from the pop-up menu.

NOTE: Command WorkStation software is supported on Windows 95/98/Me, 
Windows NT 4.0, and Windows 2000 over TCP/IP only.

Server Name—If you are using the TCP/IP protocol, enter the IP address (or DNS 
name) of the GA-1040. 

New Device—Enter the name of the device the GA-1040 is connected to:GA-1040.

4. When you have entered all the information, click Add.

5. With the device name (GA-1040) selected in the Devices list, click OK.

The GA-1040 appears in the list of available servers. The first line of the entry displays 
the nickname you gave the server, followed by the protocol you chose. The second line 
displays the device name. 

6. With the device name (GA-1040) selected in the list of Available servers, click OK 
to begin using the software.

Device Name of the GA-1040 
(GA-1040)
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Modifying the configuration

You should edit the configuration whenever there is any change to your GA-1040 
server or network, such as a server name or IP address. First change the specific 
GA-1040 Setup information before configuring the connection.

TO MODIFY THE CONFIGURATION

1. To edit information for a GA-1040 in the list of available GA-1040, select the GA-1040 
by its nickname and click Modify. 

2. Edit information in the Modify Server Settings dialog box as necessary, and click OK 
when finished.

3. To add a new GA-1040 to the list of available GA-1040s, click Add. Configure the Add 
New Server dialog box as outlined in steps 3 through 5 in the previous procedure.

4. To remove a GA-1040, select the GA-1040 by its nickname, and click Remove.

Copying the printer description files for Windows
The User Software CD contains printer description files for popular Windows 
applications. Pagemaker 5.0, 6.0, and 6.5 do not support automatic installation of 
printer description files from the Printers Control Panel. To make the GA-1040 
available in the Print and Page Setup dialog boxes of this application, copy printer 
description files to the appropriate location.

TO COPY THE PRINTER DESCRIPTION FILES

1. On the User Software CD, open the English\Prntdrvr\Ps_drvr (OS folder) folder. 

2. Copy the printer description file for your GA-1040 to the appropriate location.

If you use: Copy this file: To this location:

PageMaker 5.0 or later Efme2020.ppd For PageMaker 5.0, 
\ALDUS\USENGLSH\PPD4
For PageMaker 6.0, 
\PM6\RSRC\USENGLSH\PPD4
For PageMaker 6.5, 
\PM65\RSRC\USENGLSH\PPD4
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The general steps for installing the GA-1040 user software and setting up printing on a 
Mac OS computer are:

• Install the Adobe PostScript printer driver and PostScript Printer Description file 
(PPD).

• Set up the GA-1040 in the Chooser.

• Install the Fiery Link utility.

• Install the printer and screen fonts. 

• Copy additional application-specific files from the User Software CD as needed.

NOTE: To print from a Mac OS computer, the PS upgrade option or the HDD (hard 
disk drive) option must be installed to the GA-1040.

Installing Mac OS software
The User Software CD contains the following installers:

• Printer Driver—Adobe PostScript printer driver and PPD installer

• Fiery Link

• Fonts

Setting up the GA-1040 as a PostScript printer
To set up the GA-1040 as a PostScript printer, you must install the Adobe PostScript 
printer driver, and the PPD file that corresponds to your printer. The Adobe PostScript 
printer driver and PPD files are provided on the User Software CD.

Printer drivers provide a way to communicate information on print jobs between your 
applications, the GA-1040, and any other PostScript printer connected to your 
computer. You can use the following procedures if you are installing from the User 
Software CD whether you are installing from the User Software CD or with printer 
files downloaded using TopAccess.

Installing 
User Software 
on a Mac OS 
Computer
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TO INSTALL THE ADOBEPS PRINTER DRIVER AND PPD FILE

1. On the User Software CD, open the English: Printer Driver folder.

If you are installing from files you downloaded using WebTools, open the Printer 
Driver folder on your hard disk.

2. Double-click the AdobePS 8.7 Installer icon.

A warning dialog box appears.

3. Click Yes to continue with installation of printer driver software, and to confirm that 
your computer must be restarted after installation.

The AdobePS Installer installs the Adobe PostScript printer driver, and the PPD file 
that corresponds to your printer.

4. Click Restart when installation is complete.

NOTE: If you operate the GA-1040 in a copy shop, quick print shop, or service bureau, 
you might want to provide copies of the printer driver or PPD file used in conjunction 
with the image and relevant documentation to customers. This ensures that jobs they 
create and print to files are properly formatted for printing to the GA-1040.
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Setting up the GA-1040 in the Chooser

After you install the Adobe PostScript printer driver and PPD file (see “Setting up the 
GA-1040 as a PostScript printer” on page 53), you need to set up the GA-1040 in the 
Chooser in order to take full advantage of its features. This section describes how to set 
up the GA-1040 with the AdobePS printer driver.

TO SET UP THE GA-1040 IN THE CHOOSER

1. Select Chooser from the Apple menu.

Make sure AppleTalk is set to Active.

2. Select the correct AppleTalk Zone, if necessary.

3. Click the AdobePS icon.

The GA-1040 appears in the Select a PostScript Printer list in the form of <server 
name>_<device name>_<print connection>. The device name (GA-1040) is the 
internal name of your printer. 

NOTE: Only the print connections (Direct, Hold, and Print) that have been enabled in 
Setup appear in the Chooser. 
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4. Select a GA-1040 connection from the “Select a PostScript Printer” list, and click 
Create.

The AdobePS printer driver automatically selects the correct PPD file for your 
GA-1040.

NOTE: You will need to set up each print connection separately. Repeat step 4 for all 
enabled connections.

5. In the Chooser list, an icon appears next to the newly installed GA-1040; select it and 
click Setup.

6. Click Configure in the dialog box that appears.

7. In the Installable Options dialog box, select the appropriate settings from the pop-up 
menus, and click OK.

Pedestal Option—Not Installed, Pedestal 1, Pedestal 2, Large Capacity Feeder

Finisher Option—Not Installed, Hanging Finisher, Finisher, Saddle Stitch Finisher

Punch Unit—Not Installed, 2 Hole Punch Unit, 2/3 Hole Punch Unit, 4 Hole Punch 
Unit (F), 4 Hole Punch Unit (S)

8. Close the Chooser.
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Installing GA-1040 software and fonts
The Mac OS installers function essentially the same for each type of software. Before 
you begin each installation, determine where you want to install each item on your 
hard disk. By default, the installers place:

• Fiery Link in a folder named “Fiery f ” on the top level of your hard disk.

• Fonts in the System folder:Fonts folder on your hard disk.

For instructions on installing Fonts, see “Fonts” on page 70.

TO INSTALL MAC OS SOFTWARE

1. On the User Software CD, double-click the Fiery Link Installer icon.

2. Read the Software License Agreement, and click Accept.

3. Click Install to copy the item to the default location, or navigate to a location in 
which to install the item.

Use the table below as a guide when installing software.

4. If prompted, click Quit to close the software installer.

In order to use Fiery Link, you must have Mac OS Runtime for Java (MRJ 2.2) 
installed on your computer.

If you do not have MRJ installed, the Fiery Link installer automatically initiates the 
MRJ 2.2 installation process. 

If you are installing: Action: To install:

Fiery Link Specify a hard disk location for Fiery Link 
software.

Click 
Install.
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TO INSTALL MAC OS RUNTIME FOR JAVA

1. Read the Apple Computer Inc., License agreement and click Agree to install the 
software.

2. Click Install.

Some files are installed.

3. Click Quit.

You are now ready to configure the Fiery Link connection to the GA-1040, as 
described by the following procedure.

Configuring a connection for Fiery Link

You can use Fiery Link to monitor the status of GA-1040 and view information about 
the print jobs sent to them. 

When you click the Edit Fiery List button, all GA-1040s on the local subnet appear in 
the Available Fierys list of the My Fiery List dialog box. You can specify which 
GA-1040 to connect to and monitor from this dialog box. If the GA-1040 is not in 
your local subnet, you can use Fiery Link options to manually configure a connection, 
or you can perform an advanced search to locate and connect to GA-1040s anywhere 
on the network. The procedures below describe locating and connecting to a GA-1040 
using manual and advanced search methods.

For information on using Fiery Link, see the Printing Guide.

NOTE: Fiery Link is supported over TCP/IP only.
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TO CONFIGURE A CONNECTION TO GA-1040 IN THE LOCAL  SUBNET

1. Launch Fiery Link by double-clicking its icon.

2. The Warning dialog box “No Fierys configured, please select a Fiery” appears. Click OK.

NOTE: If the Fiery is located on a different subnet an Error dialog box appears. Click 
OK to dismiss the dialog box, and perform an Advanced IP search (page 63), or 
Advanced Subnet search (page 66).

The Edit My Fiery List dialog box opens, and all GA-1040s found appear in the 
Available Fierys area of the dialog box. 

NOTE: Only GA-1040s that support Fiery Link appear in the Available Fierys area.

GA-1040 name, device name 
(GA-1040), and IP address



60 Installing User Software on a Mac OS Computer
3. To add a server to the My Fiery List, select it and click the arrow button. 

The server appears in the My Fiery List.

Repeat step 3 for each GA-1040 you would like to add to the My Fiery List.

4. Click Apply to accept the changes to My Fiery List. 

5. Click OK. 

Arrow button
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TO MANUALLY CONFIGURE THE CONNECTION FOR FIERY LINK

1. Click the Manual tab. Enter the DNS name or IP address of the GA-1040 and click the 
arrow button.

When the arrow button is clicked, Fiery Link checks for the specified GA-1040. If the 
GA-1040 is found, it appears in the My Fiery List. If it is not found, an error message 
appears. 

To add the GA-1040 to the My Fiery List without confirming its existence on the 
network, hold down the Control key while clicking the arrow button. 
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2. To give the GA-1040 a nickname, select it in the My Fiery List and click Modify.

3. Select Use Nickname, and enter a nickname for the GA-1040.

4. Click OK.

5. Click Apply to accept the changes to My Fiery List. 

6. Click OK.
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TO CONFIGURE THE CONNECTION FOR FIERY LINK USING AN ADVANCED IP SEARCH

1. Click the AutoSearch tab.

2. Click the Advanced button.
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3. To find all GA-1040s within a specified IP range, enter an IP Address in the From IP 
field, and an IP address in the To IP field and click the arrow button.

Repeat step 3 for each range of IP addresses you would like to search. 

To remove an IP range from the list, select the range in the IP Range/Subnet Addr. 
window and click the Remove button.

You can also search for the GA-1040 using a range of subnet values. For more 
information see “To configure the connection for Fiery Link using an 
advanced subnet search” on page 66.

4. Click Search.

When the search is complete, all Fierys found appear in the Available Fierys area of the 
dialog box. 

If the GA-1040 was not found, and you would like to search again using the same 
parameters, click Refresh.

NOTE: Only Fierys that support Fiery Link appear in the Available Fierys area.
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5. To add a GA-1040 to the My Fiery List, select it and click the arrow button. 

The GA-1040 appears in the My Fiery List.

Repeat step 5 for each GA-1040 you would like to add to the My Fiery List.

6. Click Apply to accept the changes to My Fiery List.

7. Click OK. 
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TO CONFIGURE THE CONNECTION FOR FIERY LINK USING AN 
ADVANCED SUBNET SEARCH

1. Click the AutoSearch tab and click the Advanced button.

2. Click the Subnet Addr. tab. 
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3. Enter the IP address and subnet to search, and click the arrow button. 

The IP address and subnet to be searched appears in the IP Range/Subnet Addr. list. 
Repeat this procedure for each IP address and subnet you would like to search. 

To remove a value from the IP Range/Subnet Addr. list, select it and click the Remove 
button.
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4. Click Search.

When the search is complete, all Fierys found appear in the Available Fierys area of the 
dialog box. 

If the GA-1040 was not found, and you would like to search again using the same 
parameters, click Refresh.

NOTE: Only Fierys that support Fiery Link appear in the Available Fierys area.
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5. To add a GA-1040 to the My Fiery List, select it and click the arrow button. 

The GA-1040 appears in the My Fiery List.

Repeat step 5 for each GA-1040 you would like to add to the My Fiery List.

6. Click Apply to accept the changes to My Fiery List.

7. Click OK. 



70 Installing User Software on a Mac OS Computer
Fonts

The Fonts on the User Software CD includes screen and printer fonts that correspond 
to the 136 built-in PostScript printer fonts on the GA-1040. The Font installer copies 
both kinds of fonts to the System folder:Fonts folder on your hard disk. To be available 
to applications, the screen fonts must remain in the System:Fonts folder. The printer 
fonts can be copied to a folder of your choice. 

NOTE: In the System:Fonts folder, when displayed by Kind, screen fonts appear as type 
“Font Suitcase” and PostScript printer fonts appear as type “PostScript™ font”.

TO INSTALL SCREEN AND PRINTER FONTS

1. On the User Software CD, double click the Fonts icon to launch the Fonts installer. 

2. Click Install.

By default the fonts are installed to the System folder:Fonts folder on your hard disk.

If you have any applications open, you must quit and relaunch them before the newly 
installed screen fonts are available.
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TopAccess allow you to manage your GA-1040 remotely from the Internet or from 
your company’s intranet. The GA-1040 has its own home page, from which you are 
able to select from a variety of functions.

For more information on using Webtools, see the Printing Guide and the 
Configuration Guide.

Setting up TopAccess
In order for network users to set up and use TopAccess, you need to set certain 
GA-1040 options in Protocol Setup from the Touch Panel Display. You also need to 
prepare each user’s workstation to communicate with the GA-1040 over the Internet 
or intranet.

For more information about Protocol Setup, see the Configuration Guide.

TO SET UP TOPACCESS ON THE GA-1040 (DHCP)

1. Find the IP address on the Printed Settings list.

2. Use this IP address to connect to the GA-1040 using the Internet Browser.

Setting Up 
TopAccess
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TO SET UP TOPACCESS ON THE GA-1040 (STATIC IP, RARP, BOOTP)

1. Press the PRINTER/NETWORK key, then press ON/OFF and OFF LINE.

2. Press SETTING and ADMIN.

3. Enter the GA-1040 password and press SET.

4. Press Protocol Setup>TCP/IP>Ethernet.

5. Assign the IP address Subnetmask and Gateway address according to your network 
environment.

6. Press UTILITY and FUNCTION.

7. Press Reset.

TO SET UP CLIENT WORKSTATIONS TO USE TOPACCESS

1. Enable TCP/IP networking.

2. Make sure the workstation has a valid, unique IP address.

3. Make sure the workstation is installed with one of the following Internet browsers:

Windows 95/98/Me, Windows NT 4.0, and Windows 2000—Either Netscape 
Communicator v4.5 or later or Microsoft Internet Explorer v4.0.1 and SP1, or later

NOTE: Netscape and Microsoft continue to release frequent updates to their browsers. 
As support cannot be guaranteed for all versions, use the versions specified above for 
best results.

4. Make sure Java is enabled in your Internet browser.

For more information on setting up the GA-1040 and your network, see the 
Configuration Guide.
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Using the Installer WebTool
The Installer WebTool, offered from the Fiery WebTools website, allows you to easily 
download printer drivers directly from the from the GA-1040 to your workstation. 
Access Fiery WebTools from the TopAccess site.

TO DOWNLOAD THE PRINTER FILES WITH THE INSTALLER WEBTOOL

1. Launch your Internet or intranet browser and enter the DNS name or IP address of the 
GA-1040.

The TopAccess main screen appears.

2. Select Options from the TopAccess menu.

3. From the Options screen, click the WebTools link.

The Fiery WebTools website appears.
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4. Select a login level, enter a password if necessary, and click OK.

No password is required to log in as Guest. You have full access to the Installer 
WebTool when logged in as Guest.

5. Click the Installer button.

6. Under the name of your operating system, click “Printer Files.”

For Windows computers, a dialog box appears, prompting you to save the file to the 
location you choose.

7. For Windows computers, browse to the location where you want to save the 
Prntdrve.exe file and click Save.

8. For Windows computers, double-click the Prntdrve.exe file browse to the location 
where you want to install the folder, and click Unzip.

The folder is installed to the location you specified.
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9. Install the appropriate printer driver for your operating system.

NOTE: Once you download the printer files, the installation process is identical to 
installing from the User Software CD. 

For instructions on installing 
the printer driver for: See:

Windows 95/98/Me “To install the PostScript or PCL Printer Driver for 
Windows 95/98/Me” on page 2

Windows NT 4.0 and/or 
Windows 2000

“To install the PostScript or PCL printer driver for 
Windows NT 4.0 and/or Windows 2000” on page 18.
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This chapter provides troubleshooting tips.

On a Windows computer

Setting up printing on Windows NT Workstations

If you have problems installing the GA-1040 with Windows NT, try installing another 
PostScript printer (such as the Apple LaserWriter IIg), and then install the GA-1040. 
Installing another printer insures that all files are properly installed and available. 
For instructions, see your Windows NT documentation.

For additional information about problems you may encounter using the Adobe 
Printer Driver for Windows NT 4.0, see the Adobe README file (ReadMeNT.txt) 
included in the prntdrvr folder on the User Software CD.

Reinstalling the Adobe PostScript Printer Driver on 
Windows 95/98/Me

If you are reinstalling the Adobe PostScript Printer Driver, delete any previous versions 
and related files before installing. Search for and delete all files named Efme2020*.* in 
the Windows\System folder. 

For additional information about problems you may encounter using the Adobe 
Printer Driver for Windows 95/98/Me, see the Adobe README file (ReadMe9x.doc) 
included in the prntdrvr folder on the User Software CD.

Problems with Fiery utilities on Windows 95/98/Me, 
Windows NT 4.0, or Windows 2000

1. If you are using Windows 95/98/Me, make sure that IPX/SPX and TCP/IP networking 
protocols are both enabled. 

See “Completing the Windows 95/98/Me IPX/SPX or IPX (Novell) connection” on 
page 10.

2. If you are using Windows NT or Windows 2000, make sure the TCP/IP networking 
protocol is enabled.

Troubleshooting
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3. Make sure that the connection is configured correctly for your site.

To check the current configuration, launch a Fiery utility and choose Open from the 
File menu. Select the GA-1040 and click Modify to see current settings. If the settings 
are incorrect, you can change them in this dialog box.

On a Mac OS computer

Setting up the GA-1040 in the Chooser

If auto-setup does not work and you are prompted to select the PPD, select the 
appropriate GA-1040 file in your System folder:Extensions:Printer Descriptions 
folder.

Select “TOSHIBA e-STUDIO45srs-PS3UC”.

Installing screen fonts

If you experience problems installing the PostScript screen fonts from the User 
Software CD to the System folder:Fonts folder, try the following:

1. Quit all applications and close all windows.

2. Create a new folder and name it “Uninstalled Fonts.”

This folder must be located outside of the System folder.

3. Move fonts that you are not using from the System folder:Fonts folder to the 
Uninstalled Fonts folder.

4. Install the fonts from the User Software CD to a folder called CD fonts. Copy the fonts 
to the System folder:Fonts folder.

5. Create an alias to the System folder:Fonts folder and to the Uninstalled Fonts folder.

6. Place both aliases on your desktop.

7. When necessary, use the aliases to open both folders and move fonts between them.

If you have any applications running, you must quit and relaunch them in order to 
view and use the newly installed fonts.

Alternately, you can try combining fonts from multiple suitcases into a single suitcase.
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